Managing Multiple Institutions in a Network Zone
CONFIDENTIAL INFORMATION

The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER

The information in this document will be subject to periodic change and updating. Please confirm that you have the most current documentation. There are no warranties of any kind, express or implied, provided in this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for convenience only and do not in any manner serve as an endorsement of that third-party material or those Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no liability for such materials.

TRADEMARKS

Ex Libris, the Ex Libris logo, Alma, campusM, Esploro, Leganto, Primo, Rosetta, Summon, ALEPH 500, SFX, SFXT, MetaLib, MetaSearch, MetaIndex and other Ex Libris products and services referenced herein are trademarks of Ex Libris, and may be registered in certain jurisdictions.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or logos.

Trademarks of various third-party products, which may include the following, are referenced in this documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32,

Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google Inc.

iPhone is a registered trademark of Apple Inc.

Copyright Ex Libris Limited, 2020. All rights reserved.
Document released: June 2020
Web address: http://www.exlibrisgroup.com

Ex Libris, a ProQuest Company
Collaborative Networks Overview

This section includes:

- Introduction to the Network Zone
- Switching Between Institutions
Introduction to the Network Zone

Alma supports collaborative networks, which are groups of institutions, such as a consortium, that share the management of metadata records, acquisitions, and/or other Alma services, such as fulfillment, resource sharing, vendor information, or administration tables. There are several benefits to centrally managing information for multiple institutions, such as:

- Information can be entered once and then distributed to the member institutions. This saves time and ensures that the information is consistent across all of the institutions.
- Centrally managed information reduces the need for administration work at each institution.
- You gain an additional service group within which services can operate. For instance, you can expose inventory from one institution to all members of your collaborative network.
- You can ensure that patrons across all institutions have unique IDs, enabling a global view of inventory usage across the network, while still providing privacy by anonymizing patron information.

For more information, see The Alma Network Zone. Each institution can choose its collaborative partners and establish a collaborative network to jointly manage shared resources.

For videos describing Network Zone fundamentals, see:

- Alma Collaborative Networks - Introduction
- Shared Bibliographic Records in the Network Zone

All members of the consortium can become member institutions in the collaborative network. An administrative Network Zone is set up. Shared information is managed in the Network Zone and distributed to the member institutions.

Alma provides many features to support working with a Network Zone, including additional resource sharing and fulfillment options and centralized management of users and configuration options.

Note

Network Zone topology is determined by Ex Libris as part of your Alma implementation. Ex Libris Support is required to...
Overview of Network Zone Functions

The following table presents tasks that can be collaboratively managed when working with a Network Zone.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch between institutions</td>
<td>Users in a collaborative network may be assigned user accounts in multiple institutions in the network. When enabled, users can switch between member institutions for which they have a user account without having to change locations.</td>
<td>Switching Between Institutions</td>
</tr>
<tr>
<td><strong>Administration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage additional staff search fields</td>
<td>You can centrally manage and distribute additional fields for staff searches.</td>
<td>Centrally Managing Additional Staff Search Fields in a Network Zone</td>
</tr>
<tr>
<td>Manage configurations</td>
<td>You can centrally manage and distribute configurations.</td>
<td>Centrally Managing Configurations in a Network Zone</td>
</tr>
<tr>
<td>Manage letters</td>
<td>You can centrally manage and distribute letters and notifications.</td>
<td>Centrally Managing Letters in a Network Zone</td>
</tr>
<tr>
<td>Manage users</td>
<td>You can centrally manage and distribute users. Distributed users become registered users at all member institutions.</td>
<td>Centrally Managing Users in a Network Zone</td>
</tr>
<tr>
<td><strong>Acquisitions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage electronic resource licenses</td>
<td>You can centrally order and manage the licenses of electronic resources.</td>
<td>Centrally Managed Licenses for Electronic Resources in a Network Zone</td>
</tr>
<tr>
<td>Manage vendors</td>
<td>You can centrally manage and distribute vendor information.</td>
<td>Sharing Vendor Information in a Network Zone</td>
</tr>
<tr>
<td>Search PO lines in the Network Zone</td>
<td>You can search PO lines by MMS ID of bibliographic records in the Network Zone</td>
<td>Searching for PO Lines by the MMS ID of Bibliographic Records in the Network Zone</td>
</tr>
<tr>
<td><strong>Resource Management</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Manage bibliographic and authority records | You can manage bibliographic and authority records at either the institution or network level. Users can add local extensions to records managed at the network level. When you import records using an import profile, when creating a patron driven acquisition, or when using the portfolio loader, you can import them to the institution or | Network-Managed Records in a Network Zone \  Deleting Unused Bibliographic Records in the ex Libris, a ProQuest Company }
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>to the network. You can link local records to network records; changes made to linked network records are automatically reflected in the local records. Information on activity related to linked records is available in a report. You can also copy local records to network records, making them network managed; this may require resolving matching issues with the copied records. Similarly, you can copy records from the network to the institution. You can also define label generation rules for digital representations in the Network Zone. Member institutions can then use their own rules or the ones from the Network Zone.</td>
<td>Network Zone Managing Representation Label Generation Rules Using a Network Zone</td>
<td></td>
</tr>
<tr>
<td>Search for network-managed records</td>
<td>A repository search can be performed over institution, community, or network records. You can configure inventory management groups to restrict access to electronic resource by institution, in addition to the usual restrictions by library.</td>
<td>Repository Search when Using a Network Zone</td>
</tr>
<tr>
<td>Search for resources in external systems</td>
<td>The external system search resources that a member institution can access depend on various factors.</td>
<td>External System Search when Using a Network Zone</td>
</tr>
<tr>
<td>Manage import profiles</td>
<td>You can share import profiles between member institutions.</td>
<td>Creating Import Profile Templates in the Network Zone</td>
</tr>
<tr>
<td>Distribute access to electronic resources</td>
<td>The Network Zone administrator can specify for any electronic portfolio, service, or collection that it is accessible only to certain member institutions.</td>
<td>Configuring Distributed Access to Electronic Resources from the Network Zone</td>
</tr>
<tr>
<td>Combine Institution and Network Zone search results</td>
<td>You can configure Alma to add the Network Zone search results to the Institution tab, eliminating the need for users to check the Network tab for additional resources available to the institution.</td>
<td>Combining Institution and Network Zone Search Results</td>
</tr>
<tr>
<td><strong>Fulfillment</strong> - See <a href="#">Fulfillment in a Network Zone</a> for more fulfillment features.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage fulfillment information</td>
<td>You can manage fulfillment information in the Network Zone and have the information distributed to the member institutions.</td>
<td>Configuring Fulfillment Information in the Network Zone</td>
</tr>
<tr>
<td>Adding Network Partners to Resource Sharing Rota</td>
<td>You can manually enrich the rota based on known holders of the requested resource by adding network partners to existing borrowing requests.</td>
<td>Adding Network Partners to Resource Sharing Rota</td>
</tr>
<tr>
<td><strong>Analytics</strong> - See <a href="#">Analytics when Using a Network Zone</a> for more analytics features.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View consolidated information</td>
<td>You can view consolidated information from all member institutions. To maintain the privacy of the users of member institutions in Analytics reports, you can anonymize user data when it is used in Analytics.</td>
<td>Anonymizing Alma Analytics Report Details</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>More Information</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Discovery</td>
<td>See Discovery when Using a Network Zone for more discovery features.</td>
<td></td>
</tr>
<tr>
<td>Present combined inventory in Discovery</td>
<td>A single Primo view can be configured to search all institutions in the collaborative network.</td>
<td>Overview of Discovery when Using a Network Zone</td>
</tr>
<tr>
<td>Define Display Logic Rules</td>
<td>You can define display logic rules for multiple institutions.</td>
<td>Defining Display Logic Rules at the Campus Level</td>
</tr>
<tr>
<td>In addition, you can allows patrons of institutions that share a common Fulfillment Network to directly request items from any non-home institution in the network.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Publish sets of records to Primo</td>
<td>You can publish records from one or all institutions in the Network Zone.</td>
<td>Publishing Bibliographic Records from the Network Zone to Primo</td>
</tr>
<tr>
<td>Manage OpenURL resolving</td>
<td>You can configure OpenURL link resolving to include electronic services for electronic resources managed in the Network Zone.</td>
<td>Resolving Electronic Resources in the Network Zone</td>
</tr>
</tbody>
</table>
Switching Between Institutions

Users in a collaborative network may be assigned user accounts in multiple institutions in the network. When enabled, users can easily switch between member institutions for which they have a user account without having to change locations.

For collaborative networks that use single sign-on for user authentication, users can switch between member institutions without having to log in when switching between institutions.

To switch between institutions:

1. Access the Go to institution pane from the persistent menu (see The Persistent Menu).

   ![Go to institution pane](image)

   Change Institution Link

2. Select the member institution to which you want to log in.

   The Alma home page of the member institution you selected opens.

You can add a widget for the Alma home page that allows you to switch between member institutions. See List of Widgets.

Note

You must have an account in a member institution to log in to it.

This feature must be enabled and configured using the customer parameters display Consortia_urls and open Consortia link options; see Configuring Other Settings.
Managing Records in a Network Zone

This section contains the following topics:

- Network-Managed Records in a Network Zone
- Repository Search when Using a Network Zone
- External System Search when Using a Network Zone
- Creating Import Profile Templates in the Network Zone
- Deleting Unused Bibliographic Records in the Network Zone
- Managing Representation Label Generation Rules Using a Network Zone
- Combining Institution and Network Zone Search Results
- Configuring Distributed Access to Electronic Resources from the Network Zone

Additional resource management features for collaborative networks include:

For videos describing cataloging in a Network Zone, see:

- Cataloging Activities in the Network Zone, Part 1: Edit, Copy, and Share
- Cataloging Activities in the Network Zone, Part 2: Import Profiles

- See Cataloging Privileges for information about cataloging permission levels and any special considerations for the Network Zone.

- To create a Network Zone authority record, edit a Network Zone record and derive the authority record from it. For more information, see Deriving an Authority Record from a Bibliographic Record.

- Holdings are linked to a bibliographic record. When relinking holdings, you can select to relink the holdings to a Network Zone bibliographic record. See Moving Holdings Between Bibliographic Holdings (Relinking). Similarly for standalone portfolios; see Linking a Portfolio to a Different Record.

- You can configure the default tab of search results to be the Network tab; see Customizing the Default Tab of Search Results.

- When searching external resources, the list of available external search resources reflects those that are enabled in the Network Zone. See Searching External Resources.

- Importing: When checking whether to delete records during match/overlay, the record cannot be deleted if it is linked to another record/another record links to it. In addition, one of the options for handling merge/overlay is to unlink the records (leaving copies in both the institution and the Network Zone). See Managing Import Profiles.

- Publishing (see also Publishing Bibliographic Records to Primo When Working with a Network Zone):
  - When you export bibliographic records from an Alma institution (or use Alma general publishing or an API GET bib), Alma returns the MMS ID of the institution’s record in the MARC 001 field. In addition, Alma returns the associated MMS ID from the Community Zone and/or Network Zone in a MARC 035 field (when they exist). See Exporting Metadata.
  - A Link Resolver Plugin integration profile (to check the validity of EBSCOhost Full-Text URLs) must be created for the Network Zone and for all the member institutions. See Configuring the Link Resolver Plugin for Checking EBSCOhost Full-Text URLs.
  - When configuring a Z39.50 integration profile, you can include the member institutions at which resources are
available. See Z39.50 Search.

- Publishing to OCLC is processed at the local institution level since this process is used to expose institutions' physical holdings. Each institution in a collaborative network determines how bibliographic and holdings records are published based on their requirements, regardless of any links to corresponding records in the Network Zone. This means that the management tag – "Export to WorldCat" is managed by each institution, and is not controlled by the Network. Changes to the Network Zone, such as adding new bibliographic records, are independent of each institution’s record management and OCLC processing. Publishing to OCLC, whether or not in a collaborative network, is determined and processed as described in When Records are Exported.

- When publishing to Google Scholar in a collaborative network, the export process must be run at the Network Zone the day before it is run at each member institution. The process includes the ability to configure parameters for groups of libraries and campuses. For more information, see Adding a Profile for a Multicampus Environment.
Network-Managed Records in a Network Zone

When working at a member institution in a collaborative network, you can manage bibliographic and authority records at either the institution or network level.

- When you create or import a new record (through various procedures), you can select to manage the record in the institution or the network. An administrator can restrict records to be managed only in the network.

- You can copy (share) local records to network records, which creates the network-managed record and links the local record to it. Before creating the record, Alma tries to match an existing network-managed record. You can also link a local record to an existing network-managed record. And you can copy (without linking) Community Zone records to create network-managed records.

Changes made to linked network records are automatically reflected in local records. You can view information on activity related to linked records in a report.

- Similarly, you can copy records from the network to the institution, either creating new, unlinked local records or new, linked local records linked to the network-managed record.

- You can add local extensions to records managed at the network level. In this way, some of the record's information is only visible at the local institution. Adding extensions to a network record automatically creates a local, linked record.

- A repository search can be performed over institution, community, or network records. You can configure inventory management groups to restrict access to electronic resources by institution, in addition to the usual restrictions by library. See Repository Search in a Collaborative Network.

- Inventory management groups can be used to restrict or enable access to inventory by institution. For more information, see Configuring Distributed Access to Electronic Resources When Working with a Network Zone.

For videos describing cataloging in a Network Zone, see:

- Cataloging Activities in the Network Zone, Part 1: Edit, Copy, and Share
- Cataloging Activities in the Network Zone, Part 2: Import Profiles

Selecting Where to Create New Bibliographic Records

There are several locations in Alma at which you have the option to create or save a new or imported record to the local institution or to the Network Zone. These locations are listed in this section.

An administrator working in a member institution can configure the parameter central_record_management to change which of these options is selected by default (DEFAULT_INSTITUTION or DEFAULT_NETWORK) or to disable the ability to add records to the local institution (ENFORCE_NETWORK). For more information, see the parameter in Configuring Other Settings.

The following locations are used to create or save a new network record:

- Importing records: When configuring a Repository type import profile, select Use Network Zone to import records to the Network Zone. When central_record_management is set to ENFORCE_NETWORK, Use Network Zone is set to yes and cannot be changed.
Similarly, when selecting what to do when there is no match for a record, in addition to the usual options Do Not Import and Import (to the institution), you can select Add to NZ to import the record to the Network Zone. For more information, see Managing Import Profiles.

The procedure is similar when importing records using a Patron-Driven Acquisitions (PDA) load file. For more information, see Patron Driven Acquisitions.

- Similarly, when importing records by creating an OCLC Connexion integration profile. See Importing Records from OCLC Connexion.

**Note**

In the OCLC Connexion integration profile, the Use Network Zone record option is used upon finding a match. Due to a technical limitation, currently you cannot select the Merge, Overlay, or Do not import options.

- Creating a new bibliographic record: In the MD editor, select Network for the Placement of new records and templates parameter (File > Options) to add a new record as a network-managed record; see Navigating the MD Editor Page. (The option Network may appear as something else if an administrator configures the network_label parameter; see Configuring Other Settings.) When central_record_management is set to ENFORCE_NETWORK, the Placement of new records and templates parameter is disabled and defaults to Network.

- Manually adding a portfolio/physical item/digital representation: The field Placement of new record appears on the relevant page for adding the item's details. Select Network to create the record in the Network Zone. (The label Network may appear as something else by configuring the network_label parameter; see Configuring Other Settings.) When central_record_management is set to ENFORCE_NETWORK, Placement of new record is disabled and defaults to Network.
New Portfolio Page

For more information see Adding a Standalone Portfolio, Adding Physical Resources, or Creating Digital Resources.

- Adding portfolios using the portfolio loader: In the Bibliographic area of the activation wizard, in the Select catalog field select Network to create bibliographic records for the portfolios in the Network Zone. When central_record_management is set to ENFORCE_NETWORK, Select catalog is disabled and defaults to Network.

Activation Wizard: File Upload Page

If no match is found in the Network Zone, the record is added to the Network Zone and the portfolio is linked to the record. When a single bibliographic record match is found in the Network Zone, a link to that record is created. When multiple matches are found in the Network Zone, no record is created and manual handling may be required. For more information see Adding, Updating, or Removing Local Portfolios in Bulk Using an Excel File.

Working with Validation Exception Profiles in the Network

See Working with Validation Exception Profiles for information about working with and configuring the validation exception profiles and refer to the following section for details specific to a Collaborative Network.

Working with Normalization Rules in the Network

Local fields added to a record using Add Local Field from a member institution can be updated or deleted using normalization rules. For details, see Managing Local Fields Using a MARC 21 Bib Normalization Job below. For network-managed records, normalization rules run only on the shared data fields.

See Working with Normalization Rules for more information.
Preventing the Addition of Local Fields to Network Zone Records

By default, when you manually add local fields to Network Zone records using the MD Editor, a warning message appears (not an error message). However, with the Validation Exception Profile, you can configure Alma to prevent these additions and display an error message instead of a warning message.

To configure Alma to not save local changes to Network Zone records:

1. On the Metadata Configuration List page (see Configuring Cataloging), select the MARC 21 Bibliographic link in the Profile column.
2. Select the Validation Exception Profile List tab.
3. Select Actions > Edit for the MARC XML Bib Metadata Editing On Save profile.
4. On the Validation Severity Profile Exceptions page, select Local field cannot be added on network record in the Add Validation Severity Exception section, and select Add Validation Severity Exception.

After you complete the Validation Exception Profile changes and a user attempts to add local fields to a Network Zone record, the user is prevented from saving the record and an error message appears on the Alerts tab.

Copying and/or Linking Local and Network Zone Bibliographic Records

Before contributing a local bibliographic record to the Network Zone, you can choose to validate changes to the record based on the Network Zone's validation routines (see Editing Validation Routines). You can link local records to Network Zone records individually or in bulk. When linking local records individually, note that for your changes to take effect, you must save the record.

To validate a record before copying it to the Network Zone:

When editing a local record in the MD editor, select Tools > Validate in Network Zone. This works similar to validating the record in the local institution (Tools > Validate), but the validation is performed against the Network's Zone's validation routines.

To link existing local records to (and possibly create) Network Zone records:

When editing a local record in the MD editor, select File > Share With Network. If central_record_management is set to ENFORCE_NETWORK (see Configuring Other Settings), the Share With Network option does not appear for most records. This option continues to appear for migrated records that are not yet part of the Network Zone.

If a match is found in the Network Zone, you can preview the match or select from among multiple matches; select Link beneath the desired matching record to link the institution record to the existing Network Zone record. If no matches are found, the institution record is linked to a new Network Zone record.
To view the version of the record before you linked it to the Network Zone, select Tools > View Versions of Original Record.

To link existing local records to Network Zone records in bulk, run the Link a set of records to the Network Zone job. For more information, see Link a Set of Records to the Network Zone on the Running Manual Jobs on Defined Sets page.

To create new local records linked to existing Network Zone records:

- When creating a new local portfolio, select Use existing title for Creation Type. The Placement of new record field is removed from the page. Use the Choose Title field to select a record in the Network Zone (or Community Zone). Selecting a Network Zone record creates a new institution record linked to the Network Zone record.
- When creating a new local digital representation, select Existing and use the Title field to select a record in the Network Zone.
- When creating a physical item, select Existing in the Choose Holding Type dialog box and then use the Title field in the Quick Cataloging page to select a record in the Network Zone.

To copy Network Zone records to local records (without linking the records), or to unlink local and Network Zone records:

When editing a Network Zone record or a linked record in the MD Editor, select File > Copy to Catalog. The result is an unlinked local copy of the record and a Network Zone copy of the record.

To copy Community Zone records to new Network Zone records (without linking the records):

In the simple Record View page for a Community Zone record (perform an All Titles search in the Community Zone and select the record title), select Copy to Network to copy the record to the Network Zone.

Adding Local Extensions to Bibliographic Records in the Network Zone

- Catalog Operator
- Catalog Manager

You can add and edit local extensions to a bibliographic record that is maintained in the Network Zone. Local extensions provide a place for you to enter local information and, at the same time, maintain the integrity to the original and ongoing updated versions of the Network Zone record for other Network Zone members.

Specifically, you can enter local information in the MARC 21 77X/78X, 09X, 59X, 69X, and 9XX fields. Local information should be added using the Add Local Extension option in the MD Editor, as described in Adding Local Extensions Using the MD Editor below.

For network members using UNIMARC metadata, local extensions are supported for the UNIMARC X9X, XX9, and 9XX fields.
Adding Local Extensions Using the MD Editor

When you are working in the MD Editor, local fields for Network Zone records are identified by the library icon.

To add a local field to a Network Zone record using the MD Editor:

1. Open a Network Zone record in the MD Editor.
2. Select **Edit > Add Local Extension** to enter a local field (see above for supported MARC 21/UNIMARC local fields).

The local field is added and is visible only to the member institution and not to other institutions.

Adding Local Extensions Using Import

When a Network Zone member selects the **Use Network Zone** option in the Profile Details section of the import profile for Repository, Update Inventory, New Order, and Digital types of import profiles, the Network Zone Records Handling section appears on the Normalization and Validation tab in the import profile.

### Note

- Only one metadata format at a time per network is supported for local extensions. That is, a network’s members can work with UNIMARC local extensions or MARC 21 local extensions, but not both.
- When a member edits a Network Zone record, the controlled vocabulary that is used is from the Network-configured controlled vocabulary (not the member-configured controlled vocabulary).

### Adding Local Extensions Using the MD Editor

When you are working in the MD Editor, local fields for Network Zone records are identified by the library icon.

**To add a local field to a Network Zone record using the MD Editor:**

1. Open a Network Zone record in the MD Editor.
2. Select **Edit > Add Local Extension** to enter a local field (see above for supported MARC 21/UNIMARC local fields).

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDR</td>
<td>#####cam##200433#r#4500</td>
<td></td>
</tr>
<tr>
<td>005</td>
<td>20090903130911.0</td>
<td></td>
</tr>
<tr>
<td>008</td>
<td>080307s2008# ####fenka####001</td>
<td></td>
</tr>
<tr>
<td>020</td>
<td>$$$a9781844036878 (U.K.)</td>
<td></td>
</tr>
<tr>
<td>950</td>
<td>$$$a aaa</td>
<td></td>
</tr>
<tr>
<td>950</td>
<td>$$$a</td>
<td></td>
</tr>
<tr>
<td>590</td>
<td>$$$a bbb</td>
<td></td>
</tr>
<tr>
<td>020</td>
<td>$$$a 1044036875 (U.K.)</td>
<td></td>
</tr>
<tr>
<td>020</td>
<td>$$$a 9781844036400 (U.S.)</td>
<td></td>
</tr>
<tr>
<td>020</td>
<td>$$$a 1044036405 (U.S.)</td>
<td></td>
</tr>
<tr>
<td>590</td>
<td>$a</td>
<td></td>
</tr>
<tr>
<td>020</td>
<td>$a</td>
<td></td>
</tr>
</tbody>
</table>

**59X Field Added as a Local Field**

The local field is added and is visible only to the member institution and not to other institutions.

### Note

A local field should not be added to the Network Zone record using the **Edit > Add Field** function. In fact, Alma should be configured to prevent this situation from occurring. For details, see Preventing the Addition of Local Fields to Network Zone Records. Only the **Edit > Add Local Extension** function should be used to add a local field.
With the **Import local extensions** parameter you can import local fields. Select the **Yes** option to add, merge, or overlay local extensions when you import records. See the above for the local fields to which this applies. When you select the **No** option, there is no impact to local extensions when importing records. The default option is **No**.

When importing local extensions with the **Import local extensions** parameter set to **Yes**, the system uses the Match Actions that you select on the Match Profile tab to determine how to handle merge and overlay actions.

When you select the **Add To NZ** option for **Upon no match** (on the Match Profile tab), the system adds local extension fields when the **Import local extensions** parameter is set to **Yes** and there is no match.

See **Managing Import Profiles** for more information.

---

**Managing Local Fields Using a MARC 21 Bib Normalization Job**

You can use the MARC 21 Bib Normalization job to normalize Network Zone-linked records that contain local fields such as the 9XX fields. This job makes changes (add, update, or delete) only to the local fields and saves them to the Institution Zone. Since these are local changes, they are not distributed to the Network Zone or other members.

This feature extends the functionality of the normalization drool (part of a normalization process) for records that are linked to the Network Zone. The normalization processes can be accessed/added on the **Normalization Processes** tab of the Profile Details page (see **Configuring Cataloging**).
To run a batch job to make global changes on local extensions on Network Zone-linked records:

1. Create a normalization rule to be selected for the Drools File Key parameter in the next steps. See To create a new normalization rule file in Working with Normalization Rules.
2. Create a normalization process for the purpose of adding local extensions to Network Zone-linked records. See To add a process in Working with Normalization Processes.
3. Create/save the set of records to be updated.
4. Run a normalization job. The job’s name is based on a normalization process that you created and appears in the list of manual jobs that you can run on defined sets. For more information, see Running Manual Jobs on Defined Sets.

Harvesting Community Zone Linked Electronic Records

With the Import CZ Records from CN/NZ Members Task job, you can Harvest Community Zone linked electronic records from members in a Network Zone and display these records in the Network Zone as linked to the Community Zone. See Import CZ Records from CN/NZ Members Task for more information.

The Network Harvesting Report

Institution bibliographic records that are linked to Network Zone records are automatically updated with any modifications that take place in the Network Zone. Alma provides a detailed Network Harvesting report that displays a list of all updates, deletions (that is, links to the resource that were deleted), and errors for these records.

The Network Harvesting report (Resource Management > Manage Inventory > Network Harvesting Report List) is available to all network member institutions and is refreshed every five minutes. It contains the following information for each resource:

- Resource ID
- Type of operation in the network (update, deletion, error)
- ID of the member institution that performed the operation
- Date of the operation

Creating Templates in the Network Zone
GND and BARE

Templates created in the Network Zone for GND and BARE automatically appear in the Templates list of member institutions, and they are identified with the Network Zone icon. For example, to create an authority record template in the Network Zone, open the MD Editor and create an authority record with the fields you want and select **Save as Template**. The template you saved appears under the Templates tab in the Network Zone and in the member institutions. In the Network Zone, the template appears with the local institution icon; and in the member institutions, the same template appears with the Network Zone icon. For more information about creating templates, see [Working with Record Templates](#).

Other Authority Templates

Other templates created in the Network for locally-managed authority records (such as LC Name, LC Subject, and so forth) are automatically available to member institutions that work with the same local authority records. In the member institution Templates list, an additional folder by the same name with (Network) appended to the name contains the Network-created templates in the Shared folder along with the out-of-the-box templates that are provided in the Shared folder.

The templates continue to be created in the same manner in the Network with different icons representing the out-of-the-box templates from the templates created locally in the Network.
Locally Created Templates in the Network

For more information about creating templates, see Working with Record Templates.
Repository Search when Using a Network Zone

Bibliographic data can be shared between member institutions in a collaborative network for cataloging and inventory purposes. See Network-Managed Records in a Collaborative Network.

When searching in a collaborative network, Alma includes a Network tab on the Repository Search page. This tab displays resources managed in the Network Zone. The Network tab appears only when searching in member institutions. This tab does not appear when searching in the Network Zone. For more information, see Institution, Community, and Network Tabs.

To configure the default selected tab for certain types of searches, see Customizing the Repository Search. You can ask Ex Libris to enable a feature that allows you to display results from your Network Zone in the Institution tab; see Combining Institution and Network Zone Search Results.

Note

- Since inventory is not maintained in the Network Zone, a Physical Titles search using the Network tab produces no results. Use the All Titles search when doing a search from the Network tab.
- When enabled by Ex Libris, you can combine the network results in your Institution tab. See Combining Institution and Network Zone Search Results.

The Institution tab includes records that are linked (or not) to the Network and Community Zones. The Network tab presents all bibliographic records that are linked to the Community Zone. The links to the Community Zone are the same for the Institution tab and the Network tab.

The following is an example of search results in the Network tab.

Network Tab Search Results

Note

See Held By Details for information regarding the Held by information.

Network Tab Actions

The following actions are available from the Network tab; see Performing Actions on the Repository Search Results Page for details:
Other actions you can perform on Network Zone records include:

- Merge duplicate Network Zone bibliographic records – The records must both be Network Zone bibliographic records. For more information on merging records, see Merging Bibliographic Records.
  
  Before merging, Alma displays a note with a list of the other member institutions that also have inventory for the secondary record, and which will be moved to the primary record. When you are logged in to the Network Zone, the note includes the number of bibliographic record changes specific to the Network Zone’s inventory. When you are logged in to a member institution, the note includes the number of bibliographic record changes specific to the local, member institution’s inventory.

  The changes to the primary bibliographic record are immediately available at the local institution at which you perform the change. For other member institutions that hold the primary bibliographic record, there may be a slight delay (up to five minutes) while Alma synchronizes the changes.

- Link to the shared bibliographic record – Select the record title link in the Network tab. On the MARC Record Simple View Page, select Link. Alma displays a message indicating that the item was linked to the local institution.

- Configure error messages for 9XX fields added to Network Zone records.

- Identify brief records – If Alma is configured for identifying brief records (see Identifying Brief Records), the MD Editor provides a Brief indicator for brief records (see Brief for more information).

  The Network Zone and each member institution may be configured (by Ex Libris) to identify brief records. The brief record algorithm configured for the Network Zone affects only Network Zone records. Local records are defined as brief according to the brief record algorithm configured for the local member institution.

  In general, it is suggested that member institutions use the same brief record algorithm for all members and for the network.

- View network members’ order details – When you open the Held by Details page by selecting a member’s Held by link in the search results, the Orders tab on the Held by Details page shows the order information for that member.

---

**Held By Details**

The Held By Details page provides additional information for each institution in the Held By list displayed in your search results. This indicator appears in the Network tab if inventory exists for the resource at one of the network member institutions, including your own.
When you select the link for one of the institutions displayed in the Held by list, the Held By Details page appears.

The left pane on the Held By Details page lists all the institutions in hyperlink format so that you can easily switch from institution to institution while the page refreshes to display the selected institution's holdings. In addition, this page provides the following tabs that contain detailed resource information:

• Holdings
• Portfolios
• Representations
• Electronic Collections
• Orders

The Holdings tab displays the following information about each holdings record for the institution that you selected in the Held by search results:

• Library that holds the resource
• Location
• Call number
• Coverage information

Coverage information appears when there is content available in the 866/867/868 $a and $z of the same field in the holdings record. All occurrences of 866/867/868 fields are reported. When there is data in the 86x $z, it is concatenated with the 86x $a of the same field so that the note appears after the holdings text such as No. 1 (2001)-No. 5 (2005) bound volume per year.

• Number of items - Select the number link to view the List of Items page (see Working with the List of Items) with the complete list of items specific to that holdings record. All related items are listed including unavailable items and unpublished items.
• Number of available items
• Number of Requests
The **Portfolios** tab displays the following information about each portfolio record for the institution that you selected in the **Held by** search results:

- Interface name
- Service type
- Material type
- Coverage

  The from/until date range of coverage information for the portfolio.
- Status (activated/deactivated)
- Public note

The **Representations** tab displays the following information about each representation record for the institution that you selected in the **Held by** search results:

- Representation label
- Number of files
- Usage type (master/derivative)
- Representation’s public note

The **Electronic Collections** tab displays the following information about each electronic collection record for the institution that you selected in the **Held by** search results:

- Name of the electronic collection
- Collection type (selective package, aggregator package, or database)
- Service type (full text or selected full text)
- Coverage (the coverage period of the electronic collection)
- Status (activated or deactivated)

The **Orders** tab displays the following information about each orders record for the institution that you selected in the **Held by** search results:

- PO line status
- PO line reference
- MMS ID
- Vendor name
- Vendor account

**Note**

Contact Ex Libris customer support if you would like Alma not to display vendor information on this tab.

- Type

For more information, see the [Enhanced Network Search Results](#) video (1:28 min.).
Other Details in the Network Tab

The following information is provided on the Other Details tab for Network tab search results:

- Related records count that links to another search results page that displays the related records.
  
  When there are blended search results in the Institution tab, additional information provided for Network Zone records includes the related records in the Network Zone.

- Reminders count that links to the List of Reminders page

- Publishing information for physical and electronic inventory with an ID number that links to the published record page

Other Details Tab in the Network Tab Search Results

The links on the Other Details tab connect to data in the Network Zone. For example, the Related Records link points to related records in the Network Zone. The Publishing information for physical and electronic inventory link only appears when network publishing to Primo is enabled in the Network Zone.

"Available For" Information in Search Results

In multicampus and collaborative network environments, Alma includes portfolio coverage information as it relates to the inventory management groups in Repository Search results (marked as Available For). For more information, see Configuring Distributed Access to Electronic Resources When Working with a Network Zone.

Inventory Management Group Coverage Statement
External System Search when Using a Network Zone

In a collaborative network, the external system search resources that a member institution can access depend on:

- How the collaborative environment is configured for saving records
- The search external resource setup (see Configuring External Search Resources)
- The configuration of the external search profiles (Configuring External Search Profiles)

These settings and configurations can be set in the member institutions and/or the Network Zone. For member institutions where Placement of new records and templates is set to the Network Zone and central_record_management is set to ENFORCE_NETWORK or DEFAULT_NETWORK (see Selecting Where to Create New Bibliographic Records), the external system search for members must be configured in the Network Zone. See External System Search for more information about configuring external resources.

Where the external resource is saved determines which external search resources are available to the user.

- When Placement of new records and templates is set to the Network Zone, the list of available external search resources reflects those that are enabled at the network level.
- When Placement of new records and templates is set to the Institution Zone, the list of available external search resources reflects those that are enabled at the institution level.
- In a side-by-side search, the placement of the opened record determines the list of available external search resources that are provided for the external search.

For other related information, see Searching External Resources.
Creating Import Profile Templates in the Network Zone

The following role can work with import profiles:

- Catalog Administrator

You can create import vendor-specific import profiles as templates in the Network Zone and share them with member institutions. For more information about creating import profiles, see Managing Import Profiles.

These templates that can be copied and then customized.

To create a Network Zone import profile template:

1. Log in to the Network Zone (not member) system.
2. Open the Import Profiles page (see Managing Import Profiles).
3. Click Add New Profile.
4. Select a profile type and click Next.
5. Enter Profile name, Originating system, and select Template for Status.
6. Click Next and complete the remainder of the profile as usual.

To copy a Network Zone import profile template to a member system:

1. Log in to a member system.
2. On the Import Profiles page (see Managing Import Profiles), select the Network tab.
3. Select Copy in the row actions list for the template with which you want to work. The Profile Details tab opens on the
Import Profile Details page.

4. Edit the import profile details to match your requirements. See Managing Import Profiles.

5. When you have completed your import profile changes, click Save.

The import profile appears in the Institution tab. By default, the copied profile has copied from information appended to the profile name.

Copied Template
Deleting Unused Bibliographic Records in the Network Zone

To delete unused bibliographic records in the Network Zone, you must first create a set of these records. Use the following jobs to manage/delete unused bibliographic records in the Network Zone:

- **Identify records that are not used in the Network** - See the Identify records that are not used in the Network job in Running Manual Jobs on Defined Sets for more information.

- **Delete Bibliographic records** - See Delete Bibliographic Records for more information.
Managing Representation Label Generation Rules Using a Network Zone

You can create digital representation label generation rules (see Configuring Representation Label Templates) in a Network Zone and distribute them to member institutions. Each member can then configure whether to use its own rule or the Network Zone's rule. When configured to do so, the Network Zone label generation rules are used by the member institution when auto-generating labels.

To manage label generation rules using a Network Zone:

1. In the Network Zone, create a label generation template rule. For information, see Configuring Representation Label Templates.
2. Open (Resources > Advanced Tools > Distribute Network Configuration) to run the Distribute Network Zone resource management changes to members job that distributes the label generation rules to member institutions.
3. In the member institution, set the network_label_template_rules_precedence parameter to true to use the Network Zone’s label generation rules instead of the locally defined rules (if any).
Combining Institution and Network Zone Search Results

The following role is required to configure this feature.

• General System Administrator

Note

This feature must be enabled by Ex Libris. Contact Support to enable combining Institution and Network Zone search results.

You can configure Alma to add the Network Zone search results to the Institution tab. This eliminates the need for the user to check the Network tab for additional resources available to the institution. The Network Zone search results continue to appear in the Network tab. For more information, see Repository Search when Using a Network Zone and Institution, Community, and Network Tabs.

Viewing Combined Search Results

When performing a search at the Institution level, you can select to view Institution or Combined results from the search results page. Select Search scope and then select the Combined results check box.

Combined Results Check Box

The following types of searches appear as combined search results in the Institution tab:

• All titles (electronic resources only)
• Electronic titles
• Electronic portfolios
• Electronic collections

In combined results, an Institution facet appears. Network resources are identified by the words From Network.
Institution Facet and From Network Identification

The icons and actions appearing with these resources are the same as those that appear for the resource in the Network tab. The total number of records indicates the combined total of both local and network resources.

Sets/Queries Containing Combined Search Results

You can save combined search queries as logical sets (see Creating Logical Sets). The Content Origin column identifies combined sets as Network and institution. The actions available for Network and institution sets are:

- Edit
- Results
- Duplicate
- Delete

Available Actions for Combined Sets

Note

Combined sets cannot be assigned to jobs, such as publishing, export, or normalization jobs.
Configuring Distributed Access to Electronic Resources from the Network Zone

The following roles can configure distributed access to electronic resources from the Network Zone:

- Repository Administrator
- General System Administrator

Note

This page is relevant only for the Network Zone. If you are working in a member institution and want to distribute access to electronic resources by campus/library (for the resources to which your institution is granted access by the Network Zone), see Configuring Distributed Access to Electronic Resources.

Alma enables you to distribute access to electronic resources for the institutions of a collaborative network implementing a Network Zone. The Network Zone administrator can specify for any electronic portfolio, service, or collection that it is accessible only to certain member institutions. Patrons searching or browsing in Discovery from a restricted institution do not see the resource in the search results, and cannot access the resource contents.

Alma uses inventory management groups to control distributed access. An inventory management group is a set of member institutions. These groups can be assigned to portfolios, services, or electronic collections.

For example, if the Network Zone wants certain electronic resources to be available to institutions A and D, but not to institutions B and C, the Network Zone can define the resources to be available for a group that contains only institutions A and D. Other institutions will then not be able to access these resources.

Inventory management groups are managed on the Inventory ‘Available For’ Management Groups page (Configuration Menu > Resources > General > Inventory Network Groups) of the Network Zone.

To add an inventory management group:

2. Enter a name for the group, optionally enter a description, and select Add and Close. The group appears on the Inventory ‘Available For’ Management Groups page.
3. Select Edit from the group’s actions list. The Inventory Management Group Details page appears.
4. Select the institution to add to the group and select Add Institution. The institution is added to the group.
5. When you are finished, select Save.

The group is now configured. You can delete the group on the Inventory 'Available For' Management Groups page.

After configuring the group, locate the portfolios, services, or electronic collections that you want to make available only for the group and configure them. For more information, see Associating a Resource with the Inventory Management Group, Associating an Electronic Collection with an Inventory Management Group, and Understanding the Effects of the Inventory Management Group. Note that these sections relate to groups that aren't using a Network Zone, but the concept is the same as for groups working with a Network Zone.

If you delete an inventory management group that is connected to inventory, the relevant setting in the inventory is also deleted and cannot be automatically restored.

---

Note

Unless you define specific inventory management group restrictions for portfolios and services separately from the inventory management group restrictions that are defined for the electronic collections with which they're associated, portfolios inherit inventory management group restrictions from electronic services, and services from electronic collections. These restrictions appear at the top of the Group Settings tab of the service or collection. For more information about inheriting group restrictions, see the E-Resources: Inherited "Available For" Groups video.
Fulfillment in a Network Zone

This section includes:

- Configuring Fulfillment Information in the Network Zone
- Adding Network Partners to Resource Sharing Rota
Configuring Fulfillment Information in the Network Zone

To configure fulfillment information in the Network Zone, you must have the relevant role for configuring the table.

You can manage entries for the following resource sharing tables in the Network Zone. These entries are then distributed to all member institutions by the Distribute Central Resource Sharing Configuration job.

- Resource Sharing Partners - See Resource Sharing Partners
- Rota Templates - See Configuring Rota Templates
- Workflow Profiles - See Configuring Workflow Profiles
- Rota Assignment Rules - Configuring Rota Assignment Rules
- Locate Profiles - See Configuring Locate Profiles
- Sending Borrowing Request Rules - See Configuring Sending Borrowing Request Rules

In addition, you can manage and distribute the following from the Network Zone to member institutions using the Distribute Network Fulfillment Changes to Members job. To configure this job, see Configuring Fulfillment Jobs.

- Item Policies - See Configuring Item Policies
- Terms of Use - See Configuring Terms of Use
- Discovery Interface Display Logic Rules - See Discovery Interface Display Logic. The deactivation and deletion of institution rules at distribution time is controlled by the network_display_logic_distribution_members_behavior parameter. The Network Zone can also check the network_display_logic_rules_precedence parameter to determine which rules take precedence - the institution's or the network's. For more information on both parameters, see Configuring Other Settings.

**Note**

If a display logic rule is distributed from a Network Zone with a user group that doesn't exist in the member institution, the user group will be null in the rule. The rule will then affect only users with no user group.

- Fulfillment Units - See Configuring Fulfillment Units
- General Electronic Services - See Configuring General Electronic Services. When the general electronic service has been distributed, the local list will show either the distributed records only or both the distributed records and the previous local general electronic service records, depending on the configuration in the customer parameter, network_ges_distribution_members_behavior. This parameter controls what is done with the members' records when the Network Zone's records are distributed. Valid values are: Remove, Deactivate, and None. Remove will remove all the local records. Deactivate will retain the local records but deactivate them. None leaves all previously existing records exactly as they were before the distribution.

**Note**

If a service is distributed from the Network Zone with the same name as a service already in the member institution, both services will exist. If a display logic rule exists to hide the original service, both services will be hidden.
Other fulfillment tables can also be managed in the Network Zone; see Centrally Managing Configurations in a Network Zone.

Shared entries are noted with a green checkmark on the relevant table or have the scope Network. You can use the entries as is on your local institution. Where relevant, you can select Duplicate from the row actions list in the local entry on the relevant page to create a local copy of the entry and change it according to your requirements.

You can run these jobs by selecting Fulfillment > Advanced Tools > Distribute Resource Sharing Network Configuration and Fulfillment > Advanced Tools > Distribute Fulfillment Network Configuration. Select Confirm in the confirmation dialog box. (After the Distribute network fulfillment changes to members job runs, the distribute_fulfill_changes_last_run is set to the run date; see Configuring Other Settings.).
Adding Network Partners to Resource Sharing Rota

• For more information about adding network partners to the rota, see the Add Network Partners to Rota video (3:32 mins).

• For other videos about resource sharing in a network zone, see Resource Sharing.

Institutions working with a Network Zone can manually enrich the rota based on known holders of the requested resource by adding partners to existing borrowing requests from a Network Zone search. The row action, View Network Resources, appears on a borrowing request of member institutions.

Borrowing Requests Task List

Selecting the row action opens the Network Zone search results list. The search parameters are the same as they are for View Local Resources.

Network Search Results List

If a query cannot automatically be created (for example, the locate by field OCLC does not exist in the request), a query will run with a single condition of Tag Suppressed equals false.

When selecting one of the institutions from the Held By line, select the Add Partner row action to add the partner to the bottom of the rota. The partner added is the partner that is configured with an Institution Code that matches the selected Held By institution. If the partner record has a Holding Code, it is added if the Holdings Code matches the library or campus code of the selected Held By holdings record.
An Add Partner drop-down list and button also appear at the bottom of the Held By Details page, even if there are not any holdings. The drop-down list is split into two sections:

- Held By - Partners that cover the holdings in the holdings list.
- Not Held By - The rest of the institution's partners that do not cover the holdings.

On all tabs aside from the Holdings tab, the Add Partner drop-down list displays all partners in an unsorted list.

Select Rota to view the rota tab of the request.
Acquisitions in a Network Zone

This section includes:

- [Centrally Managed Licenses for Electronic Resources in a Network Zone](#)
- [Searching for PO Lines by the MMS ID of Bibliographic Records in the Network Zone](#)
- [Sharing Vendor Information in a Network Zone](#)

Additional acquisition features for collaborative networks include:

- License terms related to collaborative networks; see [Managing License Terms](#).
- Bibliographic records created by [patron driven acquisitions (PDA)](#) can be created in the Network Zone.

For videos describing acquisitions in a Network Zone, see:

- [E-Acquisitions Workflows and Management in the Network Zone](#)
- [Patron-Driven Acquisitions (PDA) Management in the Network Zone](#)
Centrally Managed Licenses for Electronic Resources in a Network Zone

In a collaborative network, you can negotiate licenses with vendors on behalf of multiple member institutions. You can then 1) acquire resources on behalf of all institutions using a license, enabling each institution to pay for the resources associated with that license as required, and/or 2) enable each member institution to acquire its own resources using a negotiated license. Both of these scenarios can exist simultaneously.

In the first scenario, you add a license called a negotiation license. The Network Zone links the relevant resources to the license, enabling member institutions to order them under this license. Unlike other licenses entered into Alma that are used only for informational purposes, a negotiation license serves a functional effect in Alma: an electronic resource managed by the Network Zone cannot be ordered unless both the resource and the member institution are linked to a negotiation license. The resource must be activated in the Network Zone, and the member institution's license period must be current in the license.

For more information about ordering electronic resources negotiated and managed by the center office in the Network Zone, see the Order E-Resources Negotiated and Managed in the NZ by a Member video (9:35 mins).

Negotiation licenses managed by the Network Zone also may record price per year for multiyear licenses to allow for a price increase between years. A negotiation license with start and end dates spanning more than one year will display the Price per year and Price increase fields. When a PO line is created for a resource, the links to a multiyear license in the Network Zone, the price of the PO line will be updated by the price per year for the member institution. When the PO line is renewed, the fund will be checked to verify that there is enough money for the renewal based on the Price per year and Price increase field. If the fund does not have enough, the renewal will fail. If the Price per year and Price increase fields are left empty, the standard functionality will apply.

In the second scenario, the license is a centrally managed license, created in the Network Zone and pushed to the member institutions, like other centrally-managed Network Zone information. You can push a regular license or a negotiation license this way (a negotiation license becomes a standard license in the member institution). In this scenario, each member institution can purchase resources and attach them to their local copy of the license.

In a member institution, a centrally managed license is noted by a checkmark in the Shared column in the Licenses and Amendments page.

Adding a Negotiation License or a Centrally Managed License

The following role can add a negotiation license or a centrally managed license:

- License Manager (for the Network Zone)

To add a negotiated license:

1. Log in to the Network Zone for your collaborative network.
2. While adding a license (see Adding a License), the License type field appears in the Summary tab of the License Details page. To add a negotiation license, select Negotiation in this field. Note: You can select License to add a standard license, as usual.
3. Regardless of which license type you select in the previous step, optionally select **Shared License** to push the license to all member institutions, enabling each one to purchase resources and attach them to their local copy of the license.

4. When you finish entering information, select **Save**. The license is saved and you are returned to the list of licenses. If you selected **Shared License**, the license is pushed to member institutions the next time that the Distribute Network Acquisition Changes to Members job runs. If you push a **Negotiation** type license this way, the license changes to type **License** in the member institution. To push the license manually, see Distributing Centrally Managed Licenses.

5. For a Negotiation license:
   
   1. Select **Edit** in the row actions list to open the license. Select the **Negotiation Details** tab.

   License Details Page - Negotiation Details Tab

   2. On the **Negotiation Details** tab, select **Add Member**. The Summary page appears.

   Summary Page

   3. Enter a member institution and any additional details for the license.
4. Select the content that is specific to this member.

5. Select Next. Step 2 of the wizard appears.

6. Enter contact details for the member and select Save. Adding a contact creates a contact user (see Managing Users).

7. Select Save to save the license. To add additional contact people:
   1. On the Negotiation Details tab, edit the institution (select Edit in the row actions list).
   2. Select the Contact People tab.

3. Select Add Contact, enter the contact person information, and select Save.

4. When you are done adding people, select Save to save the license.

When editing a member institution, you can also add notes or attachments in the Notes or Attachments tabs of a Negotiation license, respectively. For more information on these tabs, see Common Alma Tabs.

---

**Distributing Centrally Managed Licenses**

Centrally managed licenses are distributed automatically by the Distribute Network Acquisition Changes to Members job when they are created or updated. You can also manually distribute the license. You can select which information to distribute to member institutions. The license includes the Distribution check boxes. Summary and License Terms are shown but are sent by default and cannot be unselected. Notes and Attachments are optional selections.
When Notes or Attachments information has been shared to the member institutions, if the Network Zone institution edits the Distribution fields and removes one or both options, the data that was previously copied to the member institution is retained.

For shared licenses, member institutions can view the license but not edit it.

**To manually distribute the license:**

1. On the Licenses and Amendments page (Acquisitions > Acquisitions Infrastructure > Licenses), select Distribute to member in the row actions list. This option only appears on the Network Zone for centrally managed licenses that have an Active status. A list of member institutions appears.

2. Select the members to which to distribute the license, select Submit, and select Confirm in the confirmation dialog box. The Distribute network Acquisition changes to members job runs. To view the report, see Viewing Completed Jobs.

Note the following:

- If the license in the Network Zone does not have a vendor code in either the Licensor or Licensing agent field, the license is distributed.
- If the license in the Network Zone has a vendor code in either the Licensor or Licensing agent field, but the vendor is not distributed, the license is not distributed.
- If the license in the Network Zone has a vendor code in either the Licensor or Licensing agent field, and the vendor is distributed, the license is distributed as well.

---

**Linking an Electronic Resource to a Negotiation License**

To link an electronic resource to a license, see Adding a Local Electronic Collection, Editing a Portfolio Using the Electronic Portfolio Editor, and Associating a License to a Portfolio.
Ordering a Centrally Managed Electronic Resource

The following roles can order electronic resources associated with a negotiation license:

• Inventory Operator or Manager (Institution Zone/Consortium Member)

If an activated electronic resource is managed by the Network Zone and associated with a negotiation license, and your institution is listed and currently active in the negotiation license, you can order the resource for your institution.

You can now place an order on electronic resources that are managed centrally in the Network Zone even if they do not have a license of type **Negotiation**.

The functionality can be divided between those orders of centrally managed electronic resources that have a license negotiation, and those that do not have a license negotiation.

**Orders with a license negotiation**

• If the license negotiation specifies that the resource is negotiated for the member, the order will be created in the Institution Zone with all the negotiation information.

• If a license negotiation exists for the resource, but the resource was not negotiated for the member:
  ◦ The user is prompted with the following message, "Please notice that this resource has a negotiated license on the Network Zone and your institution is not part of it. Do you want to create a local order?"
  ◦ The member can place an order, which is created in the Institution Zone and linked to the centrally managed resource. The member can then create a local license and associate it to a local order.

**Orders without a license negotiation**

• If the resource is available for the member, as defined by the group configuration, it can be ordered with the **Order** action. The order is created locally and linked to the Network Zone resource.

• You can create a local license in the Institution Zone and associate it with the locally created order.

On the License Details page, in the **Inventory** tab, the **Resources from the Network** section shows electronic collections and portfolios. This section is available for orders with or without a license negotiation.

**License Details Page - Inventory Tab**

The local license can include terms of use that are viewable by the end user via the link resolver in the Primo **View It** tab. This action is available for orders with or without a license negotiation.

**Electronic Portfolio from a Network Resource**

Even if the resource is linked by a negotiation license in the Network Zone, the resource may not be available for the current institution if the institution is not part of the negotiation. In this case, it is still possible to order the resource from the **Network** tab.

**To order a centrally negotiated electronic resource:**

1. Log in to Alma as a member institution of a consortium.
2. Search for the electronic resource in the Network Zone (the **Network** tab). See **Searching in Alma**.
3. Find the resource and select **Order** in the row actions list.
The PO Line Owner and Type form appears. See Manually Creating a PO Line.

4. Order the resource, as described in Manually Creating a PO Line. Alma creates a purchase order for the institution. This PO line is linked to the centrally managed inventory in the Network Zone. The Inventory tab of the Institution Zone PO line lists the Network Zone inventory to which the PO line is linked.

Note

Your institution’s name and code appear in the Collection Available For filter and in the Available For field.
Searching for PO Lines by the MMS ID of Bibliographic Records in the Network Zone

You can search for PO lines by MMS ID of bibliographic records in the Network Zone if the PO line links to a cached version of the Network Zone's bibliographic record. For more information on searching for PO lines, see Searching for PO Lines.

For more information about working with reporting codes, see the Search for PO Line by MMS ID video (1:05 mins).

To search for PO lines by MMS ID of bibliographic records in the Network Zone:

1. Use the repository search to search for the relevant bibliographic record (see Searching for PO Lines).
2. Select the Network tab on the results page. Locate the relevant bibliographic record.
3. Select the title of the relevant bibliographic record. The simple Record View page appears (see Viewing Metadata Read-Only in the Simple Record View Page). The MMS ID appears in the record information at the top of the page. Use this ID to find the related PO lines that link to this bibliographic record.
Sharing Vendor Information in a Network Zone

Global information about vendors, such as the vendor's name, code, and address, can be shared between member institutions in a Network Zone. This alleviates the need for each member institution to add this basic information.

The Network Zone can define any global information about a vendor. In addition, each member institution can define a new vendor's global information, or change the shared global information about an existing vendor, and then share it with the Network Zone. The Distribute Network Acquisition Changes to Members job runs on the Network Zone and distributes all global vendor information from the Network Zone to member institutions. The job distributes all global vendor information added to the Network Zone since the date set by the acq_distribute_changes_last_run parameter (Configuration > Acquisitions > General > Other Settings). If the parameter is empty, all global vendor information in the Network Zone is distributed to the member institutions when the job runs.

**Note**

A vendor is uniquely identified by its code. When a vendor manager pushes vendor information to the Network Zone, or when the Network Zone pushes information to its member institutions, Alma creates a new vendor if a vendor with that code doesn't already exist. Otherwise, the new information overwrites the existing information in that vendor.

Each member institution continues to define local information for vendors, such as vendor accounts, EDI information, access providers, and vendor interfaces. If a vendor is a material supplier, the vendor is distributed as active and by default receives an account with the same name and code as the global vendor. If a vendor is not a material supplier, the vendor is distributed as inactive and remains as such in the member institution until certain local information, such as a vendor account, is added and the vendor is activated.

The global information fields of a vendor are as follows:

- Name
- Code - This field cannot be changed by a member institution.
- Additional Code
- Financial System Code
- National Tax ID
- Liable for VAT
- Libraries
- Currencies
- Language
- Material Supplier/Subscription Agent
- Access Provider
- Licensor
- Governmental
- Contact Information - Note that the Preferred indication is local.
  - Addresses
  - Phone Numbers
For more information about working with shared vendors in a collaborative network, see the [Shared Vendors in the Network video](#) (6:44 mins).

You must have one of the following roles to enable the Distribute Acquisition Changes to Member job:

- Acquisitions Administrator
- General System Administrator

You must have the following role to contribute global information to the Network Zone from a member institution:

- Vendor Manager

**To enable the Distribute Network Acquisition Changes to Members job:**

1. On the Acquisitions Configuration page ([Configuration > Acquisitions > General > Other Settings](#)), set `acq_distribution_job` to `true`.
2. Optionally set `acq_distribute_changes_last_run` to a specific date; see above for a description of this parameter.
3. Select `Save`.

**Note**

For more information, see [Configuring Other Settings](#).

4. In the list of scheduled jobs, activate *Distribute Network Acquisition Changes to Members*. For more information, see [Distribute Central Resource Sharing Configuration](#).

On the Search Vendors page ([Acquisitions > Acquisitions Infrastructure > Vendors](#)), the **Shared** column indicates which vendors are shared by member institutions. Newly shared vendors are initially inactive.

**Shared Vendor Column**

Select **Edit** to view the global information about a shared vendor. Global information is grayed out. You can continue to edit any local fields, as usual.
On the **Contact Information** tab, the **Shared** column indicates which information is shared.

**Vendor Details - Contact Information Tab**

**To contribute global information of a new vendor to the Network Zone:**

In a network member institution, on the **Search Vendors page**, locate a local vendor, select **Contribute** from the row actions, and select **Confirm** in the confirmation dialog box.

**Note**

This operation will fail if another institution already contributed this vendor's information (according to the vendor code). This can occur between the time that the other institution contributed the vendor and the time that the distribution job runs.

**To change global information of a shared vendor and contribute those changes to the Network Zone:**
1. In a network member institution, on the Search Vendors page, locate the vendor and select **Edit**. The **Summary** tab of the Vendor Details page appear.

2. Select **Edit Global Attributes**, and select **Confirm** in the confirmation dialog box. The global information fields become active (except for the **Code** field, which cannot be changed).

3. Make your changes and select **Save**. Your changes are sent to the Network Zone and will be distributed the next time the [Distribute Network Acquisition Changes to Members job](#) runs.

**To mark a shared contact information entity (address, phone number, email address, or web address) as preferred:**

You cannot edit shared contact information, which is where you would normally find the **Preferred** field for each entity type. Instead, if you want to set a shared vendor's contact information as preferred, select **Set as Preferred** from the row actions beside the entity on the **Contact Information** tab on the Vendor Details page. This option appears only for shared vendors that are not preferred.
Administering a Network Zone

This section includes:

- [Centrally Managing Users in a Network Zone](#)
- [Centrally Managing Configurations in a Network Zone](#)
- [Centrally Managing Letters in a Network Zone](#)
- [Centrally Managing Additional Staff Search Fields in a Network Zone](#)

Additional administrative features for collaborative networks include:

- For information on administering sandboxes in a consortia, see [Multiple Sandboxes in a Collaborative Network](#).
- There are several manual jobs that you can run related to network-managed bibliographic records. See the relevant job entries in [Running Manual Jobs on Defined Sets](#).
- There are several jobs that distribute changes in key tables from the Network Zone to member institutions. See the relevant job entries in [Viewing Scheduled Jobs](#).
- A user in the Network Zone can monitor jobs running on the Network Zone or on any member institution. For more information, see [Viewing Running Jobs](#) and [Viewing Completed Jobs](#).
Centrally Managing Users in a Network Zone

You can manage users in the Network Zone and distribute them to member institutions. A distributed user becomes registered at every institution in the Network Zone. (Also see Linking Users in Collaborative Networks.)

SIS may be run once in the Network Zone institution and external users distributed to all member institutions. The update process updates existing records at each member institution, but it does not create a new record for a user that does not exist in a member institution. The user record at the member institution is automatically retrieved from the Network Zone when required, for example:

1. When loaning to the patron
2. When placing a request for the patron
3. When the patron logs in using an external IdP

When the SIS load is run at the Network Zone, all of the external data is distributed to the member institutions if a local record has already been created. This excludes roles, proxy for, and statistics. Local data is not overwritten at the member institution.

To find a user that has not been distributed (meaning a user in the Network Zone), a search may be performed in the member institution using a Network scope:

1. Welcome, User, Admin Tuesday, February 6, 2018
2. Search Zone:
   - Institution
   - Network
   - Community

Alma Search

To enable the distribution of external users, please contact Ex Libris customer support.

To distribute a user from the Network Zone to the member institutions:

On the Find and Manage Users page (Administration > User Management > Find and Manage Users), select Distribute from the row actions list for a user and select Confirm in the confirmation dialog box. Alternately select Save and Distribute at the top of the User Details page when editing a user. The user is distributed to the member institutions in the network.

Sharing User IDs within a Fulfillment Network in a Network Zone

In a fulfillment network in a Network Zone, if a patron is not distributed, when the patron from institution A walks into institution B, the patron’s information is retrieved from institution A as the first step of managing the patron’s activities. Alma’s default behavior is that each user’s identifier fields (such as student ID, barcode, etc) remain non-unique between institutions. These identifiers are not copied from the other institution. (Alma maintains an internal field to track the user's identity among institutions.)

Alternately, in a fulfillment network in a Network Zone, Ex Libris can configure that user identifiers remain identical for that patron at all institutions in the fulfillment network. For example, the fulfillment network can be configured such that a specified user name configured at one fulfillment network institution is automatically configured in the linked record at the other institutions.
Note
If you use the same IDs to identify students at multiple institutions, ensure that these IDs are unique at all member institutions.

To activate or to modify these settings after they have been configured, contact Ex Libris Support. Also see Linking Users in Fulfillment Networks.
Centrally Managing Configurations in a Network Zone

The roles that allow you to perform configurations for the various functional areas can access this feature.

You can manage configurations in the Network Zone and distribute them to member institutions. For cases where a given configuration is the same for multiple or perhaps all member institutions within a network, it is more efficient to create, maintain, and distribute a single version of the configuration. This applies, in some cases, to entire tables that are configured and distributed from the Network Zone. In other cases, certain rows within a table can be configured and distributed from the Network Zone. This capability is only available for certain configuration rows and tables. See Centrally Managing Configuration Tables at the Row Level and Centrally Managing Configuration Tables at the Table Level for more information. The workflow is different for the table-level versus the row-level centrally managed configurations.

As part of the workflow, you distribute configurations to member institutions using special jobs intended for this purpose. See Jobs for Centrally Managing Configurations and Profiles in the Network Zone for more information.

By default, local changes are not overwritten by the Network Zone. As a result, if a member institution configures a table or row (within a table) that is centrally managed by the Network Zone, the centrally managed copy is not distributed to that member institution. Optionally, the member institution can select Restore (to the original out-of-the-box value) for the locally configured table or row; and when the Network Zone runs the next distribution job (see Jobs for Centrally Managing Configurations and Profiles in the Network Zone), the centrally managed configuration from the Network Zone is distributed to the member institution. Note that if there is a case that requires the Network Zone to force an override of a local configuration at multiple member institutions, contact Ex Libris Support for assistance.

If for some reason a Network Zone administrator turns off a distribution job, configurations on the member institutions are not restored to their out-of-the-box values.

For videos describing Centralized Configuration Options in a Network Zone, see Centralized Configuration Options in Collaborative Networks.

Jobs for Centrally Managing Configurations and Profiles in the Network Zone

The jobs listed below are provided for centrally managing configurations in the Network Zone:

- **Distribute network acquisitions changes to members** – See Distribute Network Acquisitions Changes to Members for more information.

- **Distribute network fulfillment changes to members** – See Distribute Network Fulfillment Changes to Members for more information.

- **Distribute network zone configuration table changes to member institutions** – The Distribute network zone configuration table changes to member institutions job distributes changes made to the Network Zone to the member institutions. See Viewing Completed Jobs for more information.

- **Distribute network letter templates changes to members** – See Centrally Managing Letters in a Network Zone for more information.

- **Distribute central resource sharing configuration** – See Distribute Central Resource Sharing Configuration for more information.
• Distribute network resource management changes to members – See Configuring Description Templates and Managing Representation Label Generation Rules Using a Network Zone for more information.

• Distribute network user management configuration changes – The Distribute network user management configuration changes job distributes changes made in the Network Zone for role profiles and role assignment rules to the member institutions. The job is accessed from Admin > Distribute User Management Configuration. When the job completes successfully, the run date updates the distribute_user_management_changes_last_run parameter with the date for use the next time the job runs. The network_user_profiles_and_assignment_rules_distribution_members_behavior parameter controls how the members’ user profiles and assignment rules are handled when the Network Zone’s records are distributed. For information on the parameters, see Configuring Other Settings (User Management). For information on the job, see Viewing Completed Jobs.

• Distribute network administration changes to members – The Distribute network administration changes to members job distributes changes made in the Network Zone to member institutions for the profiles listed below, unless the member institution already has a profile of the same type configured locally. This job is accessed from Admin > Advanced Tools > Distribute Administration Network Configuration. See Viewing Completed Jobs for more information.

  ◦ SAML (see SAML-Based Single Sign-On/Sign-Off for more information)

    If the SAML profile is marked as Manage in Network in the Network Zone, the copy distributed to the member is set to view-only access.

  ◦ S/FTP (see Configuring S/FTP Connections for more information)

  ◦ SRU (see SRU/SRW Search for more information)

    When the SRU profile is distributed to members, the content of the General and Actions tabs (not the Contact Info tab) are copied to the member institutions.

    After the member institution receives the distributed profile contents, the General tab is editable and the Actions tab is view only. With the Unlink from Network row action (see SRU/SRW Search for more information), the member institution can disconnect from the Network Zone version of the integration profile and modify it for local use.

  ◦ Z39.50 (see Z39.50 Search for more information)

    When the Z39.50 profile is distributed to members, the content of the General and Actions tabs (not the Contact Info tab) are copied to the member institutions.

    After the member institution receives the distributed profile contents, the General tab is editable and the Actions tab is view only. With the Unlink from Network row action (see Z39.50 Search for more information), the member institution can disconnect from the Network Zone version of the integration profile and modify it for local use.

These profiles are centrally managed in configuration tables at the row level. See Centrally Managing Configuration Tables at the Row Level for more information.

---

**Centrally Managing Configuration Tables at the Row Level**

To centrally manage configuration tables configured at the row level:

1. In the Network Zone, select a configuration table that is configured at the row level.

2. Select Customize from the row actions list for the row that you want to manage in the Network Zone and select Manage in Network.
Row Configuration Table

A green check mark appears in the **Managed in Network** column of the row, indicating that the row is managed by the Network Zone.

3. Perform any customizations that you want to distribute to member institutions.

4. Select **Save** to save the configuration changes without distributing them to member institutions or select **Save and Distribute** and **Confirm** in the confirmation dialog box to save the configuration changes and immediately run the distribution job.

The configuration changes are distributed to the member institutions when the distribution job runs. After the job runs, the **Updated By** column in the table has the value **Network**.

5. To stop centralized management of this table row, select **Stop Network Management** for the row, and then select **Save and Distribute** and **Confirm** in the confirmation dialog box.

Stop Network Management

Configuration changes performed in the Network Zone are no longer distributed to member institutions.
Centrally Managing Configuration Tables at the Table Level

To centrally manage configuration tables configured at the table level:

1. From the Network Zone, select a configuration table that is configured at the table level.

2. Select **Manage Table in Network**.

   The value for the **Managed in Network** field for the table changes to **Yes** and the **Stop Network Management** link and **Save and Distribute** button appear.

3. Perform any customizations that you want to distribute to the member institutions.

4. Select **Save** to save your changes without distributing them to member institutions or select **Save and Distribute** to save the configuration changes and distribute them. If you select **Save and Distribute**, a confirmation dialog box appears.

   **Distribute Table to Network Members Confirmation Dialog Box**

   1. In **Distribution Mode**, optionally select **Override Member Institution Customization** to overwrite any local
changes on member institutions.

2. Select Confirm to run the distribution job.

The configuration changes are distributed to the member institutions when the distribution job runs. After the job runs, the value for Managed in Network changes to Yes and the value in the Updated By column changes to Network in the member institutions.

5. To stop centralized management of this table, select Stop Network Management, and then select Save and Distribute and Confirm in the confirmation dialog box:

![Stop Network Management](image)

Stop Network Management

Configuration changes performed in the Network Zone are no longer distributed to member institutions.

For a video on Centralized Management of Configuration Tables, see the Centralized Management of Configuration Tables video.
Centrally Managing Letters in a Network Zone

To access this feature, you must have one of the following roles:

- General System Administrator
- Letter Administrator

For more information about letters in Alma, see Configuring Alma Letters.

You can manage letters in the Network Zone and distribute them to member institutions.

The following conditions apply:

- By default, Network Zone changes to do not override letter and label changes made by a member institution. When selecting Save and Distribute for letters or labels, you can override the default by selecting Override member institution customization. Templates are never overridden by the Network Zone. Selecting Restore letters' retention table from the row actions list in the member institution allows the Network Zone to distribute changes to the institution again. Restore in this case briefly restores the original (out-of-the-box) letter, but this letter is overwritten by the most recent Network Zone configured letter the next time the distribution job runs.

- If the Network Zone administrator turns off the distribution job, letters on the member institutions are not restored to their out-of-the-box values.

The Distribute Network Letter Templates Changes to Members job distributes any changes made to letters in the Network Zone to the member institutions; see Viewing Completed Jobs.

To centrally manage letters:

1. In the Network Zone institution, find the desired letter (Configuration Menu > General > Letters > Letters Configuration) and select Manage Activation in Network from the row actions list.

2. Perform any required customizations to the letter template or labels.
3. Select **Save and Distribute**. Select whether or not these changes should override any customizations made by the member institution in the **Distribution Mode** drop-down box. Select **Confirm** in the confirmation dialog box to distribute the changed letters.

The distribution job runs and the changed letters are distributed to the member institutions. For letters, the value **Activation** appears in the **Managed in Network** column, both in the Network Zone and the member institution. For letter labels, a check mark appears in the **Managed in Network** column. For a template, there is a **Manage in Network** check box.

4. To stop centralized management of a notification letter templates, on the Network Zone select **Stop Activation Network Management** from the row actions list for the letter and select **Save and Distribute**.

   ![Stop Network Management](image)

   **Stop Network Management**

   Letter changes performed in the Network Zone are no longer distributed to member institutions.

5. To distribute the entire list of letter retention periods to the member institutions, select the **Manage Letters’ Retention in Network** link.
Centrally Managing Additional Staff Search Fields in a Network Zone

In the Network Zone, you can customize the search results display of the additional local fields for staff search and distribute these customizations to member institutions. For information about customizing the display of additional staff search fields, see Configuring the Display of Additional Staff Search Fields.

Distributing Additional Staff Search Fields Customizations

As described in Centrally Managing Configurations in a Network Zone, you can centrally distribute your additional staff search field customizations.

To distribute additional staff search fields customizations from the Network Zone:

1. On the Additional Fields For Network Zone Search Results mapping table page (Configuration > Resources > Search Configuration > Additional Staff Search Fields), select the ellipsis button for the row/field that you want to distribute; and select Manage in Network.

2. Select Save and Distribute.

3. From the Confirm pop-up window, select the distribution mode; and select Confirm.
Analytics When Using a Network Zone

This section includes:

• Configuring Analytics to Display Network Zone Information

Note

If an Analytics report is run in the Network Zone, all member institutions are included when selecting the Institution Code and Institution Name fields of the Institution dimension.
Configuring Analytics to Display Network Zone Information

You can create reports in Alma analytics containing information from the Network Zone. To configure this option, set a parameter in the Network Zone and in the member institutions.

To configure the Network Zone:

1. From the Analytics configuration page (Configuration > Analytics), select Analytics Networks Settings.

![Analytics Networks Setting](image)

2. Set the analytics_network_inventory_available_for_members to true.
3. From the row actions, select Manage in Network.
4. Select Save and Distribute.
5. From the light-box, select Override member institution customization and select Confirm.

To configure the member institution:

1. From the Analytics configuration page (Configuration > Analytics), select Analytics Member Settings.

![Analytics Member Settings](image)

2. Set the analytics_network_inventory_available_for_my_institution to true.
3. Select Save.

You can now create reports that include Network Zone data.

---

**Note**

When creating reports with Network Zone data, use the fields from E-Inventory > Portfolio Details for Consortia. If you want to create reports that do not include Network Zone data, use fields from other dimensions and either filter the results to be just from your institution or include the Institution > Institution Code field in the report.
Discovery when Using a Network Zone

This section includes:

- Overview of Discovery when Using a Network Zone
- Defining Display Logic Rules at the Campus Level
- Publishing Bibliographic Records to Primo When Working with a Network Zone
- Resolving Electronic Resources in the Network Zone
- Central Publishing in the Network

Additional discovery features in a collaborative network include:

- When Alma publishes data in XML format, the $$b$$ subfield contains the entity type instead of the INT field. See The Format of Published Data.
- Patrons who have accounts in multiple institutions working with a Network Zone can view all of their accounts from My Account by selecting the institution at the bottom of the My Account menu. The current institution appears at the top of the menu.
Overview of Discovery when Using a Network Zone

In a collaborative network, a Primo view can be configured to search all institutions, receive availability of print resources that are held by all institutions, and request applicable print services for resources that are held by all institutions.

Availability and delivery for physical resources harvested from Alma (Alma-P) are relative to the institution of the view. Records that do not belong to the institution of the view default to the Check Holdings status. For more information, see Availability Statuses.

If Alma provides priority information for locations in the AVA $$P$$ field, Primo displays the matching location with the highest priority instead of the first location that matches the availability status. For more information, see Configuring Best Location.

The Get It tab enables users to display the availability and holdings for other institutions in the collaborative network and to request resources from them. For more information, see The More Link and Institutions Lightbox.

Note
Availability for electronic resources (Alma-E) that appear in the View It tab is always based on the Alma institution to which the user belongs.

Availability Statuses

The Calculated Availability Text code table provides availability statuses for a record's brief results:

<table>
<thead>
<tr>
<th>Code</th>
<th>Status/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>default.delivery.code.check_holdings_in_maininstitution</td>
<td>Check holdings – The institution of the view has the item, but because Primo does not have enough information, the user must check the detailed holdings in the ILS.</td>
</tr>
<tr>
<td>default.delivery.code.does_not_exist_in_maininstitution</td>
<td>Check holdings – The institution of the view does not have the item, but because Primo does not have enough information, the user must check the detailed holdings in the ILS.</td>
</tr>
<tr>
<td>default.delivery.code.unavailable_in_maininstitution_more</td>
<td>Check holdings – The item is not available in the institution of the view, but it belongs to additional institutions.</td>
</tr>
<tr>
<td>default.delivery.code.available_in_maininstitution</td>
<td>Available at {1} – There is an available item in the institution of the view.</td>
</tr>
<tr>
<td>default.delivery.code.unavailable_in_maininstitution_nomore</td>
<td>Checked out – The item is not available in the institution of the view and does not belong to additional institutions.</td>
</tr>
</tbody>
</table>

For more information on real-time availability, see Configuring Real-Time Availability.

The More Link and Institutions Lightbox

The Get It tab displays the current institution (which defaults to the institution of the view), its holdings, and any additional
services offered from the resource sharing and fulfillment networks. Patrons can display holdings from other institutions (if any exist) by selecting the More link next to the current institution name. The number of additional institutions is shown in parentheses.

Selecting the More link displays a list of the additional institutions and their calculated availability statuses. To update labels in the Institution lightbox, use the Institution Lightbox Labels code table in the Primo Back Office.

Patron can select an institution to display the Get It tab with holdings and services for the selected institution.

---

**Note**

Although real-time availability is only invoked for the institution of the view in the brief results, it is invoked for all institutions when the Institutions lightbox is opened.

If the More link is not necessary for your network, you can hide the link from end users by creating or modifying a custom CSS file on the Primo server and adding the following line to it:

```
.EXLTabHeader div.EXLTabHeaderContent em.EXLTabHeaderContentAdditionalDataLine a {display:none;}
```

---

**Requests from Any Member Institution**

Patrons of institutions in a fulfillment network can request items from any institution in the network.

The patron must be locally registered at that institution. Alma provides automatic registration of the patron at the non-home institution.

When discovering a Primo record that has inventory at more than one institution, the patron can view the inventory of another institution by selecting the More link in the Primo Get It tab. If the user selects a non-home institution in the network, the system automatically registers the patron at that institution, allowing the user to view the available request options and place requests based on the new locally-registered linked patron record. For more information on selecting institutions, see The More Link and Institutions Lightbox.

---

**Note**

This feature is dependent upon the configuration of a fulfillment network. To configure a fulfillment network, contact your Ex Libris representative.

In addition, users may be permitted to place resource sharing requests using their own institutions, which interact with other institutions to obtain the requested resources for the users.

---

**Sharing Digital Inventory with Member Institutions**

Ex Libris can enable or disable whether a member institution shares its digital inventory. When enabled for a member institution, that member institution's digital inventory is available to all other member institutions. When digital inventory is viewed by a patron in a specific member institution's discovery system, there is no indication as to the source of the inventory.

To enable or disable this feature for the Network Zone or a member institution, contact Ex Libris Support.
Defining Display Logic Rules at the Campus Level

The following roles are required to update display logic rules:

- Fulfillment Administrator
- General System Administrator

For more information about configuring display (discovery) logic rules, see Discovery Interface Display Logic.

For multicampus environments, Alma allows you to define display logic rules at the campus level for the following electronic services: full text, selected full text, database services, and general electronic services. Alma applies the display logic rules in multicampus environments as follows:

- The campus for which the services are calculated is based on the IP address from which the patron triggers the Alma Services page or the campus affiliation of the logged-in patron. If Alma determines that a patron is logged on at a different campus, the calculated electronic services are based on the display logic rules defined for both campuses.
- Display logic rules that are enabled at the campus level override all electronic display logic rules enabled at the institution level.
- For non-electronic services, Alma also applies the display logic rules that are enabled at the institution level.
- If no campus-level display logic rules are enabled, Alma applies all display logic rules that are enabled at the institution level.

To define display logic rules at the campus level:


   ![](Add Rule Dialog Box)

2. Select one of the following electronic services from the hide service drop-down list: DB Service, Full Text, General Electronic Service, or Selected Full Text.
3. Select a campus from the **when in campus** drop-down list

4. Fill out the remaining fields and select **Add and Close**.

The Add Rule dialog box closes, and the new rule is added under the Campus Rules section on the Discovery Interface Display Logic page.

To view rules for another campus, select the campus from the **Campus** drop-down filter.
Publishing Bibliographic Records to Primo When Working with a Network Zone

Publishing Records to a Shared Primo Instance

You can publish records from the Network Zone and from all member institutions directly from the Network Zone using the Network Publishing Job job. The records published include:

- All records that are managed in the Network Zone.
- All Network Zone records that are linked to local records. These records are enriched with local data from members (such as course information (CNO), local fields, availability, electronic availability, and so forth). Course information is included when an item is associated with a citation in a reading list associated with an active course.
- All local records in member institutions that are marked for publication by the Mark records to be published by Network Zone job, see Republishing Specific Records from the Network Zone below.

Note

- When a Network Zone record is attached to only one Institution Zone record and the Institution Zone record is suppressed, the Network Zone record is nevertheless not suppressed.
- If an Institution Zone record is linked to the Community Zone, it will not be published by this job. For the record to be published by this job, it must be linked to the Network Zone, and from the Network Zone to the Community Zone.
- Alma returns the MMS ID of the institution’s record in the MARC 001 field. In addition, Alma returns the associated MMS ID from the Community Zone and/or Network Zone in a MARC 035 field (when they exist). See Exporting Metadata.

For general information on publishing to Primo, see Exporting Alma Records to Primo.

To publish bibliographic records from the Network Zone:

1. Open the Publishing Profiles page (Resources > Publishing > Publishing Profiles).
2. In the row that contains the **Publish bibliographic records from Network Zone to Primo** profile, select **Edit** from the row actions list. The Publishing Profile Details page appears.

3. Configure the following fields as described in the table below:
### Field Details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile Details section:</strong></td>
<td></td>
</tr>
<tr>
<td>Profile name and description</td>
<td>Update these fields as required.</td>
</tr>
<tr>
<td><strong>Publishing Parameters section:</strong></td>
<td></td>
</tr>
<tr>
<td>Also publish via members</td>
<td>See the Publishing Records to Member Institutions' Individual Primo Instances below.</td>
</tr>
<tr>
<td>Status</td>
<td>Select <em>Active</em>.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Select one of the scheduling options that are preconfigured by Ex Libris staff. If you select <strong>Not scheduled</strong>, the export job will run only when you manually run it (select <strong>Actions &gt; Run</strong> for the profile from the Publishing Profiles page).</td>
</tr>
<tr>
<td>Email notifications</td>
<td>Opens the Email Notifications for Scheduled Jobs page, which allows you to specify which users and email addresses will receive email notifications when the publishing profile has completed. You will have the option to choose whether to send the notifications for successful jobs and/or jobs that contain errors.</td>
</tr>
<tr>
<td><strong>Submission Format section:</strong></td>
<td></td>
</tr>
<tr>
<td>FTP configuration</td>
<td>By default, the publishing process places the exported files in a directory that Primo uses to harvests the files. This field specifies a predefined profile that contains the FTP information. If the transfer fails, the system includes a link to the published files in the publishing report. <strong>Note</strong> The directory must be configured in advance because Alma cannot create it. From the drop-down list, select the name of the S/FTP connection that you previously defined.</td>
</tr>
<tr>
<td>Sub-directory</td>
<td>The subdirectory in which the exported files are placed. For example, if you specified <em>Alma</em> in the Sub-directory field during S/FTP connection configuration and you enter <em>Primo</em> in this field, the data is exported to the <em>Alma/Primo</em> directory.</td>
</tr>
<tr>
<td><strong>Content Options section:</strong></td>
<td></td>
</tr>
<tr>
<td>Related records information enrichment</td>
<td>Select this option to specify whether related record information is to be included with the bibliographic records.</td>
</tr>
<tr>
<td>Member relations enrichment</td>
<td>Select the <strong>Member relations enrichment</strong> parameter in the Network Zone's Publish bibliographic records from Network Zone to Primo configuration profile to publish related record information for member institution records linked to the Network Zone from the Network Zone to Primo.</td>
</tr>
</tbody>
</table>
In order for the Member relations enrichment parameter to appear as an option, you must first select the Related records information enrichment parameter. For information regarding related records, see Configuring Related Records for Physical Inventory and Configuring Related Records for Electronic Services. Also, see the Publishing to Primo page for more information.

After you configure the Network Zone's Publish bibliographic records from Network Zone to Primo configuration profile with the Member relations enrichment parameter, additional data is sent to Primo when the Publish bibliographic records from Network Zone to Primo job runs. For details regarding the additional information that is sent, see Network Zone or Member Institution Name Data and Title Data below.

**Network Zone or Member Institution Name Data**

The Network Zone or member institution name data is sent in subfield c of the PLK field. The purpose of sending this information (in subfield c) is to identify the source of the related record information. See the examples below.

**XML with the Network Zone Related Record Information:**

```
<datafield tag="PLK" ind1=" " ind2=" ">
  <subfield code="a">Additional Form.</subfield>
  <subfield code="b">99110387010001451</subfield>
  <subfield code="c">Network_Zone</subfield>
</datafield>
```

**XML for a Member Institution with Related Record Information in a Record Linked to the Network Zone:**

```
<datafield tag="PLK" ind1=" " ind2=" ">
  <subfield code="a">Additional Form.</subfield>
  <subfield code="b">99110387010001234</subfield>
  <subfield code="c">Member_Institution</subfield>
</datafield>
```

When the member linked record has inventory (physical items) and it is a host record, the availability of the inventory is also published to Primo (in the AVA field).

**Title Data**

The title data is sent in the following subfields of the PLK field: d, e, f, g, h, i, m, and v. See the table below for a mapping of the MARC 21 245 field and the UNIMARC 200 field to the PLK subfields.

```
<table>
<thead>
<tr>
<th>Subfield Description</th>
<th>PLK Subfields</th>
<th>MARC 21 245 Subfields</th>
<th>UNIMARC 200 Subfields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other title information</td>
<td>d</td>
<td>d</td>
<td></td>
</tr>
<tr>
<td>Remainder of title / Other title information</td>
<td>e</td>
<td>b</td>
<td>e</td>
</tr>
<tr>
<td>Statement of responsibility / First Statement of Responsibility</td>
<td>d</td>
<td>c</td>
<td>f</td>
</tr>
<tr>
<td>Medium / General Material Designation</td>
<td>g</td>
<td>h</td>
<td>b</td>
</tr>
<tr>
<td>Number of part/section of a work / Number of a Part</td>
<td>h</td>
<td>n</td>
<td>h</td>
</tr>
<tr>
<td>Name of part / section of a work / Name of a Part</td>
<td>i</td>
<td>p</td>
<td>i</td>
</tr>
</tbody>
</table>
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Subfield Description</th>
<th>PLK Subfields</th>
<th>MARC 21 245 Subfields</th>
<th>UNIMARC 200 Subfields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>m</td>
<td>a</td>
<td>a</td>
</tr>
<tr>
<td>Volume designation</td>
<td>v</td>
<td>v</td>
<td></td>
</tr>
</tbody>
</table>

Below are XML examples of the PLK field that include title information of MARC 21 related records published to Primo.

**XML with the Network Zone Related Record Information:**

```xml
<datafield tag="PLK" ind1=" " ind2=" ">
  <subfield code="a">Additional Form.</subfield>
  <subfield code="b">99110387010001451</subfield>
  <subfield code="c">Network_Zone</subfield>
  <subfield code="m">Harry Potter and the sorcerer's stone /</subfield>
  <subfield code="f"> by J.K. Rowling ; illustrations by Mary GrandPre.</subfield>
</datafield>
```

**XML for a Member Institution with Related Record Information in a Record Linked to the Network Zone:**

```xml
<datafield tag="PLK" ind1=" " ind2=" ">
  <subfield code="a">Additional Form.</subfield>
  <subfield code="b">99110387010001234</subfield>
  <subfield code="c">Member_Institution</subfield>
  <subfield code="m">Harry Potter and the sorcerer's stone /</subfield>
  <subfield code="f"> by J.K. Rowling ; illustrations by Mary GrandPre.</subfield>
</datafield>
```

Select this parameter to add the information from the parent record to the child record. The **Parent record enrichment** parameter appears after you select the Related records information enrichment parameter.

All fields from the parent record are added to the child record except for the fixed and local fields. For MARC 21 and KORMARC, the LDR, 001-009, and 9XX fields are not added. For UNIMARC and CNMARC, the LDR, 001, 003, 005, 1XX, and 9XX fields are not added.

In the file published to Primo, the parent fields are added at the end of the child published record, and the field tags for the parent record additions have the suffix of P as in the following example:

```xml
<datafield tag="020P" ind1=" " ind2=" ">
  <subfield code="a">123-4-05-067890-5</subfield>
</datafield>
<datafield tag="035P" ind1=" " ind2=" ">
  <subfield code="a">123456789</subfield>
</datafield>
<datafield tag="245P" ind1="1" ind2="0">
  <subfield code="a">Briefe :</subfield>
  <subfield code="b">historisch-kritische Ausgabe /</subfield>
  <subfield code="c">Johann Wolfgang Goethe. </subfield>
  <subfield code="m">Auftrag der Klassik-Stiftung Weimar, Goethe- und Schiller-Archiv hrsg. von Georg Kurscheidt, Norbert Oellers und Elke Richter.</subfield>
</datafield>
```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Note that this functionality is also available when publishing from a single member institution (see <a href="#">Publishing from a Member Institution</a>).</td>
</tr>
<tr>
<td>Headings enrichment</td>
<td>See <a href="#">Publishing Headings Enrichment to Primo</a>.</td>
</tr>
<tr>
<td>Note</td>
<td>This option appears only when your Network Zone is configured by Ex Libris with the Primo publishing classification enrichment customer parameter set to true.</td>
</tr>
<tr>
<td>Heading enrichment – enrich with “See Also” fields</td>
<td>See <a href="#">Publishing Headings Enrichment to Primo</a>.</td>
</tr>
<tr>
<td>Note</td>
<td>This option appears only when your Network Zone is configured by Ex Libris with the Primo publishing classification enrichment customer parameter set to true.</td>
</tr>
<tr>
<td>Classification enrichment</td>
<td>Select this option to specify that when a bibliographic record is published to Primo and it is linked to a classification authority record, the published record is enriched with the preferred/non-preferred classification data located in the 153 and 7XX fields of the authority record. The preferred/non-preferred classification data is placed in the 084 field of the bibliographic record published to Primo. See <a href="#">Working with the Regensburger Verbundklassifikation (RVK) Authority Record Classification</a> for more information.</td>
</tr>
<tr>
<td>Note</td>
<td>This option appears only when your Network Zone is configured by Ex Libris to allow classification enrichment in Primo publishing.</td>
</tr>
<tr>
<td>Physical Inventory Enrichment section:</td>
<td></td>
</tr>
<tr>
<td>Quick Add area</td>
<td>Map holdings tags/subfields from the holdings record to tags/subfields in the published bibliographic record. After you enter the above mapping data, select Add to add the new mapping to the list.</td>
</tr>
<tr>
<td>Full Option section:</td>
<td></td>
</tr>
<tr>
<td>Run full publishing for entire network</td>
<td>If this option is selected, the system publishes all records, replacing previously published data. If this option is not selected, the system publishes records that have changed since the last time they were published. This includes bibliographic records that were added, updated, deleted, and linked to inventory records that changed.</td>
</tr>
<tr>
<td>Members section:</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Which members are actively receiving incremental updates.</td>
</tr>
<tr>
<td>Run Full Publishing</td>
<td>Whether full publishing should run for the specified member at the local level. To use this option, the Run full publishing for entire network check box must not be selected in the Full Option section. For more information on this setting, see Run full publishing for entire network above.</td>
</tr>
</tbody>
</table>
4. Select **Save**.

The modified publishing profile appears activated on the Publishing Profiles page. In addition, a job **Network Publishing Job** appears in the list of scheduled jobs (see Viewing Scheduled Jobs). Data that meets the defined criteria is exported to the specified FTP location when the profile is run (either manually or according to the selected schedule).

**Note**

Alma tests the FTP connection before running the profile. If the FTP connection fails, the profile is not run, and there is no resulting loss of data. If the FTP connection fails while the export job is running, the data that was in the process of being exported is kept and included in a subsequent successful export job report.


### Republishing Specific Records from the Network Zone

The Network Zone can republish records independently from the central publishing process (Publishing Records from the Network Zone). The Network Zone republishes a selected set of records from the Network Zone or any records specifically marked by the member institutions.

Only the relevant publishing jobs appear in each institution.

- **Network Zone** -
  - **Network Zone Republish Set of Titles** - Publish selected records to Primo.
  - **Network Zone Republish Set of Titles (impl)** - Enables you to run the above job as a separate job for a test environment.

- **Member institution** -
  - **Mark records to be published by Network Zone** - Mark a set of records for the Network Zone to publish using the Network Publishing Job.
  - **Mark records to be published by Network Zone (impl)** - Enables you to run the above job as a separate job for a test environment.

**To republish a set of records from the Network Zone:**

Run the required job as described in Running Manual Jobs on Defined Sets.

**To mark records in a member institution for the Network Zone to publish:**

---

**Note**

After the job executes, Alma clears the **Run Full Publishing** column so that shared records and incremental updates for all members are included the next time the job runs as scheduled.
Run the required job as described in Running Manual Jobs on Defined Sets.

### Publishing from a Member Institution

When a member institution selects the Also publish network data option for the Publishing mode parameter in the Publish bibliographic records to Primo publishing profile (Resources > Publishing > Publishing Profiles), the member institution is able to publish to Primo all records available to it in both the Institution Zone and the Network Zone (see Publishing mode for more information). With the related record capability described in Member relations enrichment, this same capability also applies when the publishing to Primo is done from the member institution when the member institution has configured the Also publish network data option and when the Member relations enrichment parameter is selected in the Network Zone’s Publish bibliographic records from Network Zone to Primo configuration profile.

This enables the member institution's publishing process to publish related record information for all the member institution records linked to the Network Zone and not be limited to publishing only its related record information.

Note that the scenario described in this section requires the configuration of two profiles, one in the Network Zone (Publish bibliographic records from Network Zone to Primo) and the other in the member institution (Publish bibliographic records to Primo). In the Network Zone's Publish bibliographic records from Network Zone to Primo configuration profile, the Also publish via members parameter must be selected. In the member institution's Publish bibliographic records to Primo configuration profile, the Also publish network data parameter must be selected. See Publishing Records to Member Institutions' Individual Primo Instances for more information.

### Publishing Records to Member Institutions' Individual Primo Instances

In cases where each member institution publishes to its own individual Primo instance, both the Publish bibliographic records to Primo and the Publish bibliographic records from Network Zone to Primo profiles must be run. This ensures that all bibliographic record data that is relevant to the member institution, including data that is stored in the Network Zone, is published to the member institution's Primo.

The Publish bibliographic records from Network Zone to Primo profile gathers all bibliographic records that are relevant for the member institution. This includes:

- Network Zone bibliographic records used by the Institution Zone
- Network Zone bibliographic records associated with electronic resources in the Network Zone that are active and available for the member institution
- The member institution's local bibliographic records that exist only in the Institution Zone and are not linked to the Network Zone

This job enriches the relevant bibliographic records with related record, headings, and physical item information based on the options selected in the Publish bibliographic records from Network Zone to Primo profile.

The Publish bibliographic records to Primo profile then publishes the information gathered by the Publish bibliographic records from Network Zone to Primo profile to the member institution's Primo.

---

**Note**

Contact Ex Libris Support to enable the relevant options in both publishing profiles.

---

To publish to individual Primo instances:
1. Ensure that the **Also publish via members** check box is selected in the **Publish bibliographic records from Network Zone to Primo** profile.

2. Ensure that you properly define the data enrichment sections in the **Publish bibliographic records from Network Zone to Primo** profile (see above). Note that all data enrichment parameters are taken from this section and not from the data enrichment sections in the **Publish bibliographic records to Primo** profile.

3. Define the other parameters of the **Publish bibliographic records from Network Zone to Primo** profile as required. Note the caveats in the Publishing Records to a Shared Primo Instance above.

4. In the relevant member institution’s **Publish bibliographic records to Primo** profile, select the **Also publish network data** check box. See Publishing to Primo for information on setting the other parameters in the **Publish bibliographic records to Primo** profile.

Both profiles are run as configured. For information on monitoring the publishing jobs, see Viewing Running Jobs, Primo Publishing Job Report, and Viewing Network Publishing Jobs Report.

---

### Centrally Managed Electronic Resources and Publishing in a Network Zone

When electronic resources are managed in the Network Zone, the central office manages the electronic resources for the members. When the Network Zone activates an electronic resource, it is active for all members unless the Network Zone specifically determines to which member(s) the electronic resource is active for using group settings (see Configuring Distributed Access to Electronic Resources from the Network Zone).

If the Network Zone deactivates an electronic resource, that resource is inactive for all members.

For a portfolio that should no longer be active in the Network Zone but should be active in one or more member's institution zone, the portfolio needs to be deleted if it cannot be reactivated.

For central publishing in the Network Zone, the following options are available for record linking:

- A member record can be linked to the Network Zone record that is linked to a Community Zone record.
- A member record can be linked to a Community Zone record and the Network Zone record must also be linked to that Community Zone record. Note that a member record cannot be linked directly to the Community Zone without a Network Zone record being linked to the Community Zone.
Resolving Electronic Resources in the Network Zone

You can configure (set `retrieve_services_from_NZ` to `true`; see [Configuring Other Settings](#)) OpenURL link resolving to include electronic services for electronic resources managed in the Network Zone.

When enabled, any OpenURL request to the Alma Link Resolver checks the Network Zone to resolve electronic services that are available for the institution. The electronic services are presented in the View It area.

For searches within the Citation Linker for an electronic resource, the e-services available for this resource are resolved using the Network Zone and displayed in the Primo View It tab.

---

**Note**

Ex Libris typically enables this configuration for a collaborative network prior to delivery.
Central Publishing in the Network

Central publishing in the network publishes both Network Zone and member institution records. Using Alma's general publishing profile, you are able to configure and publish the following:

- All records that are managed in the Network Zone
- Member records that are linked to the Network Zone

In the general publishing profile, these records are enriched as defined by the data enrichment specifications for physical holdings, physical items, electronic inventory, and so forth. The enriched data includes the local bibliographic fields that are set by the members (the ones not included in the main Network Zone bibliographic record).

- Local member records that are not linked to the Network Zone and their enriched data

Network Zone publishing is available only for logical sets and is processed in the following manner:

1. First, the set's query is executed in the Network Zone to pull all the relevant Network Zone records.
2. The set's query is then executed in each member institution to pull the relevant member records that match the search criteria.

The publishing job report documents job results for both the Network Zone and the member institutions configured in the network's general publishing profile.

This section assumes that you are familiar with the Publishing and Inventory Enrichment (General Publishing) configuration information in the online help and provides a description of the general publishing parameters that are unique to the network's general publishing profile.

Network General Publishing Profile Configuration

Use the procedure below to supplement the configuration instructions provided in the Publishing and Inventory Enrichment (General Publishing) section.

To configure the network general publishing profile:

In the Network, access the Publishing Profiles page (Resources > Publishing > Publishing Profiles), select Add Profile > General Profile, and refer to the table below for a list of the general publishing profile configuration parameters that are specific to a network configuration.

<table>
<thead>
<tr>
<th>Configuration Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Section</td>
<td></td>
</tr>
</tbody>
</table>

Note

From the Set name box, you can select only a logical set and not an itemized set.
<table>
<thead>
<tr>
<th>Configuration Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish on</td>
<td>For the Publish on parameter in the Content section, select the <strong>Bibliographic level</strong> option.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image of Bibliographic Level Option" /></td>
<td><strong>Bibliographic Level Option</strong></td>
</tr>
<tr>
<td>Physical Holdings Enrichment Section</td>
<td>Specify a target field / subfield to which the member code should be published for holdings. When several members have holdings for the same title, the member code helps to identify which members the holdings belong to.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image of Member Code Field / Subfield" /></td>
<td><strong>Member Code Field / Subfield</strong></td>
</tr>
<tr>
<td>Physical Items Enrichment Section</td>
<td>Specify a target subfield to which the member code should be published for items. This subfield is attached to the field specified in the Repeatable field parameter.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image of Repeatable field / Member code subfield" /></td>
<td><strong>Repeatable field / Member code subfield</strong></td>
</tr>
</tbody>
</table>
### Configuration Parameters

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
</table>

#### Electronic Inventory Enrichment Section

**Repeatable field / Member code subfield**

Specify a target subfield to which the member code should be published for electronic inventory. This subfield is attached to the field specified in the Repeatable field parameter.

#### Digital Inventory Enrichment Section

**Repeatable field / Member code subfield**

When you select either Add Digital Representation Information or Add Remote Representation Information or both, specify a target subfield to which the member code should be published for digital inventory. This subfield is attached to the field specified in the Repeatable field parameter.
<table>
<thead>
<tr>
<th>Configuration Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Collection Enrichment Section</strong></td>
<td>Specify a target subfield to which the member code should be published for collections. This subfield is attached to the field specified in the Repeatable field parameter.</td>
</tr>
<tr>
<td>Repeatable field / Member code subfield</td>
<td></td>
</tr>
</tbody>
</table>
| **Member Details Enrichment Section** | Specify a target subfield to which the following should be published for member details enrichment:  
- Member code  
- Member name  
- Member bibliographic MMS record ID  
These subfields are attached to the field specified in the Repeatable field parameter.  
For published bibliographic records, this enables you to identify the members that have the published title. |
| Repeatable field / Member code subfield / Member name subfield / Member BIB MMS ID subfield |  |
| **Local Bibliographic Enrichment Section** |  |

**Member Code Subfield for Digital Inventory**

**Member Code Subfield for Collections**

**Member Details Enrichment**

Ex Libris, a ProQuest Company
<table>
<thead>
<tr>
<th>Configuration Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Member code subfield</td>
<td>Specify a target subfield to which the member code should be published for local fields. This subfield is attached to the local field that contains the member's local data. This identifies the member to which the local data belongs. When the <strong>Add Member Local Fields</strong> check box is selected, a member's local bibliographic fields (fields not included in the network's bibliographic record) are included in the publishing. Select this option to include a member's local data.</td>
</tr>
</tbody>
</table>

**Local Bibliographic Enrichment**

<table>
<thead>
<tr>
<th>Members Section</th>
<th>In the Active column, enable each member whose records you want to publish. With this feature, you can have all members participate or selectively identify certain members' records for publishing. In this section, the list of members identifies each member's institution code and name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active (column)</td>
<td><strong>Identify Which Members to Publish</strong></td>
</tr>
</tbody>
</table>

### Network General Publishing Job Report

For central publishing from the network, the general publishing job report includes a Members' Local Records Report section. This section identifies record counts for local records (not linked to the Network Zone) published per member.

The Records processed count in the top portion of the job report includes the total number of records published from both the Network Zone and the members.

The Network Zone Report section of the report is the same with or without members included in the publishing.

**Network General Publishing Job Report**